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Introduction

This chapter provides an introduction to the concepts and terms of Parallel
Computing Toolbox™ software and MATLAB® Distributed Computing
Server™ software.

Product Overview (p. 1-2) Overview of the Parallel Computing
Toolbox product and the MATLAB
Distributed Computing Server

product
Toolbox and Server Components Descriptions of the parts and
(p. 1-4) configurations of a parallel

computing setup

Using Parallel Computing Toolbox™ Introduction to Parallel Computing
Software (p. 1-8) Toolbox software programming with
a basic example



Introduction

Product Overview

In this section...

“Overview” on page 1-2

“Determining Product Installation and Versions” on page 1-3

Overview

Parallel Computing Toolbox™ software and MATLAB® Distributed Computing
Server™ software enable you to coordinate and execute independent
MATLAB® operations simultaneously on a cluster of computers, speeding

up execution of large MATLAB jobs.

A job is some large operation that you need to perform in your MATLAB
session. A job is broken down into segments called tasks. You decide how best
to divide your job into tasks. You could divide your job into identical tasks,
but tasks do not have to be identical.

The MATLAB session in which the job and its tasks are defined is called the
client session. Often, this is on the machine where you program MATLAB.
The client uses Parallel Computing Toolbox software to perform the definition
of jobs and tasks. The MATLAB Distributed Computing Server product
performs the execution of your job by evaluating each of its tasks and
returning the result to your client session.

The job manager is the part of the server software that coordinates the
execution of jobs and the evaluation of their tasks. The job manager
distributes the tasks for evaluation to the server’s individual MATLAB
sessions called workers. Use of the MathWorks® job manager is optional;
the distribution of tasks to workers can also be performed by a third-party
scheduler, such as Windows® Compute Cluster Server (CCS) or Platform
LSF® scheduler.

See the “Glossary” on page Glossary-1 for definitions of the parallel computing
terms used in this manual.



Product Overview

MATLAB Client

Parallel
Computing
Toolbox

Scheduler

or
Job Manager

MATLAB Worker

MATLAB Distributed
Computing Server

MATLAB Worker

MATLAB Distributed
Computing Server

Basic Parallel Computing Configuration

MATLAB Worker

MATLAB Distributed
Computing Server

Determining Product Installation and Versions
To determine if Parallel Computing Toolbox software is installed on your

system, type this command at the MATLAB prompt:

ver

When you enter this command, MATLAB displays information about the

version of MATLAB you are running, including a list of all toolboxes installed

on your system and their version numbers.

You can run the ver command as part of a task in a distributed or parallel
application to determine what version of MATLAB Distributed Computing

Server software is installed on a worker machine. Note that the toolbox and

server software must be the same version.

1-3
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Toolbox and Server Components

In this section...

“Job Managers, Workers, and Clients” on page 1-4
“Third-Party Schedulers” on page 1-6

“Components on Mixed Platforms or Heterogeneous Clusters” on page 1-7

“mdce Service” on page 1-7

Job Managers, Workers, and Clients

The optional job manager can run on any machine on the network. The job
manager runs jobs in the order in which they are submitted, unless any jobs
in its queue are promoted, demoted, canceled, or destroyed.

Each worker receives a task of the running job from the job manager, executes
the task, returns the result to the job manager, and then receives another
task. When all tasks for a running job have been assigned to workers, the job
manager starts running the next job with the next available worker.

A MATLAB® Distributed Computing Server™ network configuration usually
includes many workers that can all execute tasks simultaneously, speeding up
execution of large MATLAB® jobs. It is generally not important which worker
executes a specific task. Each worker evaluates tasks one at a time, returning
the results to the job manager. The job manager then returns the results of all
the tasks in the job to the client session.

Note For testing your application locally or other purposes, you can configure
a single computer as client, worker, and job manager. You can also have more
than one worker session or more than one job manager session on a machine.
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Interactions of Parallel Computing Sessions

A large network might include several job managers as well as several
client sessions. Any client session can create, run, and access jobs on any
job manager, but a worker session is registered with and dedicated to only
one job manager at a time. The following figure shows a configuration with

multiple job managers.
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Third-Party Schedulers

As an alternative to using the MathWorks® job manager, you can use a
third-party scheduler. This could be a Microsoft® Windows® Compute Cluster
Server (CCS), Platform LSF® scheduler, PBS Pro® scheduler, TORQUE
scheduler, mpiexec, or a generic scheduler.

Choosing Between a Scheduler and Job Manager

You should consider the following when deciding to use a scheduler or the
MathWorks job manager for distributing your tasks:

¢ Does your cluster already have a scheduler?

If you already have a scheduler, you may be required to use it as a means
of controlling access to the cluster. Your existing scheduler might be just
as easy to use as a job manager, so there might be no need for the extra
administration involved.

¢ [s the handling of parallel computing jobs the only cluster scheduling
management you need?

The MathWorks job manager is designed specifically for MathWorks
parallel computing applications. If other scheduling tasks are not needed, a
third-party scheduler might not offer any advantages.

¢ Is there a file sharing configuration on your cluster already?

The MathWorks job manager can handle all file and data sharing
necessary for your parallel computing applications. This might be helpful
in configurations where shared access is limited.

® Are you interested in batch or interactive processing?

When you use a job manager, worker processes usually remain running at
all times, dedicated to their job manager. With a third-party scheduler,
workers are run as applications that are started for the evaluation of tasks,
and stopped when their tasks are complete. If tasks are small or take little
time, starting a worker for each one might involve too much overhead time.

® Are there security concerns?

Your scheduler may be configured to accommodate your particular security
requirements.

¢ How many nodes are on your cluster?
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If you have a large cluster, you probably already have a scheduler. Consult
your MathWorks representative if you have questions about cluster size
and the job manager.

® Who administers your cluster?

The person administering your cluster might have a preference for how
jobs are scheduled.

Components on Mixed Platforms or Heterogeneous
Clusters

Parallel Computing Toolbox™ software and MATLAB Distributed Computing
Server software are supported on Windows, UNIX®, and Macintosh® operating
systems. Mixed platforms are supported, so that the clients, job managers,
and workers do not have to be on the same platform. The cluster can also be
comprised of both 32-bit and 64-bit machines, so long as your data does not
exceed the limitations posed by the 32-bit systems.

For a complete listing of all network requirements, including those for
heterogeneous environments, see the System Requirements page for MATLAB
Distributed Computing Server software at

http://www.mathworks.com/products/distriben/requirements.html

In a mixed platform environment, be sure to follow the proper installation
instructions for each local machine on which you are installing the software.

mdce Service

If you are using the MathWorks job manager, every machine that hosts a
worker or job manager session must also run the mdce service.

The mdce service recovers worker and job manager sessions when their
host machines crash. If a worker or job manager machine crashes, when
mdce starts up again (usually configured to start at machine boot time), it
automatically restarts the job manager and worker sessions to resume their
sessions from before the system crash.


http://www.mathworks.com/products/distriben/requirements.html
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Using Parallel Computing Toolbox™ Software

A typical Parallel Computing Toolbox™ client session includes the following
steps:

1 Find a Job Manager (or scheduler) — Your network may have one or more
job managers available (but usually only one scheduler). The function you
use to find a job manager or scheduler creates an object in your current
MATLAB® session to represent the job manager or scheduler that will
run your job.

2 Create a Job — You create a job to hold a collection of tasks. The job exists
on the job manager (or scheduler’s data location), but a job object in the
local MATLAB session represents that job.

3 Create Tasks — You create tasks to add to the job. Each task of a job can be
represented by a task object in your local MATLAB session.

4 Submit a Job to the Job Queue for Execution — When your job has all its
tasks defined, you submit it to the queue in the job manager or scheduler.
The job manager or scheduler distributes your job’s tasks to the worker
sessions for evaluation. When all of the workers are completed with the
job’s tasks, the job moves to the finished state.

5 Retrieve the Job’s Results — The resulting data from the evaluation of the
job is available as a property value of each task object.

6 Destroy the Job — When the job is complete and all its results are gathered,
you can destroy the job to free memory resources.
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This chapter provides information useful for network administration
of Parallel Computing Toolbox™ software and MATLAB® Distributed

Computing Server™ software.

Preparing for Parallel Computing
(p. 2-2)

Installing and Configuring (p. 2-5)

Shutting Down a Job Manager
Configuration (p. 2-6)

Customizing Server Services
(p. 2-10)

Accessing Service Record Files
(p. 2-14)

Troubleshooting (p. 2-16)

Examines network requirements
and limitations for running Parallel
Computing Toolbox software and
MATLAB Distributed Computing
Server software

Where to find installation and
configuration instructions

Terminating parallel computing
processes on your cluster

Overriding or modifying default
parameters for scripts

Accessing service logs and specifying
their locations

Diagnosing and solving problems
with your cluster
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Preparing for Parallel Computing

In this section...

“Before You Start” on page 2-2
“Planning Your Network Layout” on page 2-2
“Network Requirements” on page 2-3

“Fully Qualified Domain Names” on page 2-3

“Security Considerations” on page 2-4

This section discusses the requirements and configurations for your network
to support parallel computing.

Before You Start

Before attempting an installation of Parallel Computing Toolbox™ software
and MATLAB® Distributed Computing Server™ software, read Chapter 1,
“Introduction” to familiarize yourself with the concepts and vocabulary of
the products.

Planning Your Network Layout

Generally, there is not much difficulty in deciding which machines will run
worker processes and which will run client processes. Worker sessions usually
run on the cluster of machines dedicated to that purpose. The MATLAB®
client session usually runs where MATLAB programs are run, often on a
user’s desktop.

The job manager process should run on a stable machine, with adequate
resources to manage the number of tasks and amount of data expected in

your parallel computing applications.

The following table shows what products and processes are needed for each of
these roles in the parallel computing configuration.

2-2
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Session Product Processes

Client Parallel Computing MATLAB with toolbox
Toolbox

Worker MATLAB Distributed worker; mdce service (if
Computing Server using a job manager)

Job manager MATLAB Distributed mdce service; job
Computing Server manager

The mdce service or daemon is included in the server software. It is separate
from the worker and job manager processes, and it must be running on all
machines that run job manager sessions or workers that are registered with a
job manager. (The mdce service is not used with third-party schedulers.)

You can install both toolbox and server software on the same machine, so that
one machine can run both client and server sessions.

Network Requirements

To view the network requirements for MATLAB Distributed Computing
Server software, visit the product requirements page on the MathWorks
Web site at

http://www.mathworks.com/products/distriben/requirements.html

Fully Qualified Domain Names

MATLAB Distributed Computing Server software and Parallel Computing
Toolbox software support both short hostnames and fully qualified domain
names. The default usage is short hostnames. If your network requires fully
qualified hostnames, you can use the mdce_def file to identify the worker
nodes by their full names. See “Customizing Server Services” on page 2-10.
To set the hostname used for a MATLAB client session, see the pctconfig
reference page.


http://www.mathworks.com/products/distriben/requirements.html
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Security Considerations

The parallel computing products do not provide any security measures.
Therefore, you should be aware of the following security considerations:

e MATLAB workers run as whatever user the administrator starts the node’s
mdce service under. By default, the mdce service starts as root on UNIX®
operating systems, and as LocalSystem on Microsoft® Windows® operating
systems. Because MATLAB provides system calls, users can submit jobs
that execute shell commands.

® The mdce service does not enforce any access control or authentication.
Anyone with local or remote access to the mdce services can start and stop
their workers and job managers, and query for their status.

® The job manager does not restrict access to the cluster, nor to job and
task data. Using a third-party scheduler instead of the MathWorks® job
manager could allow you to take advantage of the security measures it
provides.

¢ The parallel computing processes must all be on the same side of a firewall,
or you must take measures to enable them to communicate with each other
through the firewall. Workers running tasks of the same parallel job cannot
be firewalled off from each other, because their MPI-based communication
will not work.

¢ If certain ports are restricted, you can specify the ports used for parallel
computing. See “Defining the Script Defaults” on page 2-10.

o If your network supports multicast, the parallel computing processes
accommodate multicast. However, because multicast is disabled on many
networks for security reasons, you might require unicast communication
between parallel computing processes. Most examples of parallel computing
scripts and functions in the documentation show unicast usage.

e If your organization is a member of the Internet Multicast Backbone
(MBone), you need to ensure that your parallel computing cluster is isolated
from MBone access if you are using multicast for parallel computing. This
is generally the default condition. If you have any questions about MBone
membership, contact your network administrator.
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Installing and Configuring

To find the most up-to-date instructions for installing and configuring
the current or past versions of the parallel computing products, visit the
MathWorks Web site at

http://www.mathworks.com/support/product/DM/installation/ver_current/


http://www.mathworks.com/support/product/DM/installation/ver_current/

2 Network Administration

Shutting Down a Job Manager Configuration

In this section...

“UNIX® and Macintosh® Operating Systems” on page 2-6
“Microsoft® Windows® Operating Systems” on page 2-8

If you are done using the job manager and its workers, you might want to shut
down the server software processes so that they are not consuming network
resources. You do not need to be at the computer running the processes that
you are shutting down. You can run these commands from any machine with
network access to the processes. The following sections explain shutting down
the processes for different platforms.

UNIX® and Macintosh® Operating Systems

Stopping the Job Manager and Workers

1 To shut down the job manager, enter the commands

cd matlabroot/toolbox/distcomp/bin

(Enter the following command on a single line.)

stopjobmanager -remotehost <job manager hostname> -name
<MyJobManager> -v

If you have more than one job manager running, stop each of them
individually by host and name.

For a list of all options to the script, type
stopjobmanager -help
2 For each MATLAB® worker you want to shut down, enter the commands

cd matlabroot/toolbox/distcomp/bin
stopworker -remotehost <worker hostname> -v
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If you have more than one worker session running, you can stop each of
them individually by host and name.

stopworker -name workeri -remotehost <worker hostname>
stopworker -name worker2 -remotehost <worker hostname>

For a list of all options to the script, type

stopworker -help

Stopping and Uninstalling the mdce Daemon

Normally, you configure the mdce daemon to start at system boot time and
continue running until the machine shuts down. However, if you plan to
uninstall the MATLAB® Distributed Computing Server™ product from a
machine, you might want to uninstall the mdce daemon also, as you will no
longer need it.

Note You must have root privileges to stop or uninstall the mdce daemon.

1 Use the following command to stop the mdce daemon.
/etc/init.d/mdce stop

2 Remove the installed link to prevent the daemon from starting up again
at system reboot.

cd /etc/init.d/
rm mdce

Stopping the Daemon Manually. If you used the alternative manual
startup of the mdce daemon, you can use the following commands to stop
it manually.

cd matlabroot/toolbox/distcomp/bin
mdce stop
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Microsoft® Windows® Operating Systems

Stopping the Job Manager and Workers

1 To shut down the job manager, enter the commands

cd matlabroot\toolbox\distcomp\bin

(Enter the following command on a single line.)

stopjobmanager -remotehost <job manager hostname> -name
<MyJobManager> -v

If you have more than one job manager running, stop each of them
individually by host and name.

For a list of all options to the script, type

stopjobmanager -help

2 For each MATLAB worker you want to shut down, enter the commands

cd matlabroot\toolbox\distcomp\bin
stopworker -remotehost <worker hostname> -name <worker name> -v

If you have more than one worker session running, you can stop each of
them individually by host and name.

stopworker -remotehost <worker hostname> -name <workeri name>
stopworker -remotehost <worker hostname> -name <worker2 name>

For a list of all options to the script, type

stopworker -help

Stopping and Uninstalling the mdce Service

Normally, you configure the mdce service to start at system boot time and
continue running until the machine shuts down. If you need to stop the mdce
service while leaving the machine on, enter the following commands at a
DOS command prompt.
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cd matlabroot\toolbox\distcomp\bin
mdce stop

If you plan to uninstall the MATLAB Distributed Computing Server product
from a machine, you might want to uninstall the mdce service also, as you
will no longer need it.

You do not need to stop the service before uninstalling it.

To uninstall the mdce service, enter the following commands at a DOS
command prompt.

cd matlabroot\toolbox\distcomp\bin
mdce uninstall
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Customizing Server Services

2-10

In this section...

“Defining the Script Defaults” on page 2-10
“Overriding the Script Defaults” on page 2-12

The MATLAB® Distributed Computing Server™ scripts run using several
default parameters. You can customize the scripts, as described in this section.

Defining the Script Defaults

The scripts for the server services require values for several parameters.
These parameters set the process name, the user name, log file location, ports,
etc. Some of these can be set using flags on the command lines, but the full set
of user-configurable parameters can be accessed in the mdce_def file.

Note The startup script flags take precedence over the settings in the
mdce_def file.

The default parameters used by the server service scripts are defined in
the file

* matlabroot\toolbox\distcomp\bin\mdce_def.bat (on Microsoft®
Windows® operating systems)

® matlabroot/toolbox/distcomp/bin/mdce_def.sh (on UNIX® or

Macintosh® operating systems)

To set the default parameters, edit this file before installing or starting the
mdce service.

The mdce_def file is self-documented, and includes explanations of all its
parameters.
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Note If you want to run more than one job manager on the same machine,
they must all have unique names. You can specify the names using flags
with the startup commands.

Setting the User
By default, the job manager and worker services run as the user who starts

them. You can run the services as a different user with the following setings
in the mdce_def file.

Parameter Description

MDCEUSER Set this parameter to run the mdce services as a user
different from the user who starts the service. On a
UNIX operating system, set the value before starting
the service; on a Windows operating system, set it
before installing the service.

MDCEPASS On a Windows operating system, set this parameter
to specify the password for the user identified in
the MDCEUSER parameter; otherwise, the system will
prompt you for the password when the service is
installed.

On UNIX operating systems, MDCEUSER requires that the current machine
has the sudo utility installed, and that the current user be allowed to use
sudo to execute commands as the user identified by MDCEUSER. For further
information, refer to your system documentation on the sudo and sudoers
utilities (for example, man sudo and man sudoers).

On Windows operating systems, when executing the mdce start script,

the user defined by MDCEUSER must be listed among those who can log

on as a service. To see the list of valid users, select the Windows menu
Start > Settings > Control Panel. Double-click Administrative Tools,
then Local Security Policy. In the tree, select User Rights Assignment,
then in the right pane, double-click Log on as a service. This dialog box
must list the user defined for MDCEUSER in your mdce_def.bat file. If not,
you can add the user to this dialog box according to the instructions in

2-11
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2-12

the mdce_def.bat file, or when running mdce start, you can use another
mdce_def.bat file that specifies a listed user.

Overriding the Script Defaults

Specifying an Alternative Defaults File

The default parameters used by the mdce service, job managers, and workers
are defined in the file

® matlabroot\toolbox\distcomp\bin\mdce def.bat (on Windows
operating systems)

® matlabroot/toolbox/distcomp/bin/mdce_def.sh (on UNIX or Macintosh
operating systems)

Before installing and starting the mdce service, you can edit this file to set
the default parameters with values you require.

Alternatively, you can make a copy of this file, modify the copy, and specify
that this copy be used for the default parameters.

On UNIX or Macintosh operating systems,

mdce start -mdcedef my_mdce_def.sh

On Windows operating systems,

mdce install -mdcedef my_mdce_def.bat
mdce start -mdcedef my_mdce_def.bat

If you specify a new mdce_def file instead of the default file for the service on
one computer, the new file is not automatically used by the mdce service on
other computers. If you want to use the same alternative file for all your mdce
services, you must specify it for each mdce service you install or start.

For more information, see “Defining the Script Defaults” on page 2-10.
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Note The startup script flags take precedence over the settings in the
mdce_def file.

Starting in a Clean State

When a job manager or worker starts up, it normally resumes its session from
the past. This way, a job queue will not be destroyed or lost if the job manager
machine crashes or if the job manager is inadvertently shut down. If you
want to start up a job manager or worker from a clean state, with all history
deleted, use the -clean flag on the start command:

startjobmanager -clean -name MyJobManager
startworker -clean -jobmanager MyJobManager

2-13
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Accessing Service Record Files

In this section...

“Locating Log Files” on page 2-14

“Locating Checkpoint Directories” on page 2-15

The MATLAB® Distributed Computing Server™ services generate various
record files in the normal course of their operations. The mdce service, job
manager, and worker sessions all generate such files. The types of information
stored by the services are described in this section.

Locating Log Files

Log files for each service contain entries for the service’s operations. These
might be of particular interest to the network administrator in cases when
problems arise.

Operating System File Location

Windows® The default location of the log files is
<TEMP>\MDCE \Log, where <TEMP> is the value of
the system TEMP variable. For example, if TEMP
is set to C: \TEMP, then the log files are placed
in C:\TEMP\MDCE\Log.

You can set alternative locations for the log
files by modifying the LOGBASE setting in the
mdce_def.bat file before starting the mdce
service.

UNIX® and Macintosh® | The default location of the log files is
/var/log/mdce/.

You can set alternative locations for the log
files by modifying the LOGBASE setting in the
mdce_def.sh file before starting the mdce
service.

2-14
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Locating Checkpoint Directories

Checkpoint directories contain information related to persistence data, which
the server services use to create continuity from one instance of a session to
another. For example, if you stop and restart a job manager, the new session
will continue the old session, using all the same data.

A primary feature offered by the checkpoint directories is in crash recovery.
This allows server services to automatically resume their sessions after a
system goes down and comes back up, minimizing the loss of data. However, if
a MATLAB® worker goes down during the evaluation of a task, that task is
neither reevaluated nor reassigned to another worker. In this case, a finished
job may not have a complete set of output data, as data from any unfinished
tasks might be missing.

Note If a job manager crashes and restarts, its workers can take up to 2
minutes to reregister with it.

Platform File Location

Windows The default location of the checkpoint
directories is <TEMP>\MDCE\Checkpoint,
where <TEMP> is the value of the system TEMP
variable. For example, if TEMP is set to C: \TEMP,
then the checkpoint directories are placed in
C:\TEMP\MDCE\Checkpoint.

You can set alternative locations for the
checkpoint directories by modifying the
CHECKPOINTBASE setting in the mdce_def.bat
file before starting the mdce service.

UNIX and Macintosh The checkpoint directories are placed by default
in /var/lib/mdce/.

You can set alternative locations for the
checkpoint directories by modifying the
CHECKPOINTBASE setting in the mdce_def.sh
file before starting the mdce service.
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Troubleshoot

In this section...

“License Errors” on page 2-16
“Verifying Multicast Communications” on page 2-18
“Memory Errors on UNIX® Operating Systems” on page 2-19

“Running Server Processes from a Windows®-Based Network Installation”
on page 2-19

“Required Ports” on page 2-20
“Ephemeral TCP Ports with Job Manager” on page 2-20

This section offers advice on solving problems you might encounter with
MATLAB® Distributed Computing Server™ software.

License Errors

When starting a MATLAB® worker, a licensing problem might result in the
message

License checkout failed. No such FEATURE exists.
License Manager Error -5

There are many reasons why you might receive this error:

This message usually indicates that you are trying to use a product for
which you are not licensed. You can look at your license.dat file located
within your MATLAB installation to see if you are licensed to use this
product.

If you are licensed for this product, this error may be the result of having
extra carriage returns or tabs in your license file. To avoid this, ensure that
each line begins with either #, SERVER, DAEMON, or INCREMENT.

After fixing your license.dat file, restart your license manager and
MATLAB should work properly.

This error may also be the result of an incorrect system date. If your system
date is before the date that your license was made, you will get this error.




Troubleshooting

¢ Ifyou receive this error when starting a worker with MATLAB Distributed
Computing Server software

= You may be calling the startworker command from an installation that
does not have access to a worker license. For example, starting a worker
from a client installation of the Parallel Computing Toolbox™ product
causes the following error.

The mdce service on the host hostname
returned the following error:

Problem starting the MATLAB worker.

The cause of this problem is:

Most likely, the MATLAB worker failed to start due to a
licensing problem, or MATLAB crashed during startup. Check
the worker log file
/tmp/mdce_user/node_node_worker_05-11-01_16-52-03_953.10g
for more detailed information. The mdce log file
/tmp/mdce_user/mdce-service.log

may also contain some additional information.

In the worker log files, you will see the following information.

License Manager Error -15.

Cannot connect to license server

The server (lmgrd) has not been started yet, or

the wrong port@host or license file is being used, or the
port or hostname in the license file has been changed.
Feature: MATLAB_Distrib_Comp_Server

Server name: hostname

License path: /matlab/etc/license.dat

FLEX1m error: -15,570. System Error: 111 "Connection refused"
For further information, refer to the FLEX1m End User Manual,
available at "www.macrovision.com".

MATLAB is unable to connect to the license server.
Make sure the SERVER line in your license file is correct.

2-17



2 Network Administration

Have your MATLAB administrator verify that the license manager
is running and validate network services.

For more information, see The MathWorks Support page at
http://www.mathworks.com/support and search for
"license manager error -15"

= If you have installed only the Parallel Computing Toolbox product, and
you are attempting to run a worker on the same machine, you will
receive this error because the MATLAB Distributed Computing Server
product is not installed, and therefore the worker cannot obtain a license.

Verifying Multicast Communications

Note Though Version 3 of the parallel computing products continues to
support multicast communications between its processes, multicast is not
recommended and might not be supported in future releases.

Multicast, unlike TCP/IP or UDP, is a subscription-based protocol where a
number of machines on a network indicate to the network their interest in
particular packets originating somewhere on that network. By contrast,
both UDP and TCP packets are always bound for a single machine, usually
indicated by its IP address.

The main tools for investigating this type of packet are tcpdump or the
equivalent on Microsoft® Windows® operating systems (usually called winpcap
and ethereal), and a Java™ class included with Version 3 of the parallel
computing products.

The class is called
com.mathworks.toolbox.distcomp.test.MulticastTester. Both its static
main method and its constructor take two input arguments: the multicast
group to join and the port number to use.

This Java class has a number of simple methods to attempt to join a specified

multicast group. Once the class has successfully joined the group, it has
methods to send messages to the group, listen for messages from the group,
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and display what it receives. The class can be used both inside MATLAB and
from a call to Java software.

Inside MATLAB, the class would be used as follows.

m = com.mathworks.toolbox.distcomp.test.MulticastTester('239.1.1.1"', 9999);
m.startSendingThread;
m.startListeningThread;

0 : hostiname : O

1 : host2name : O

From a shell prompt, you would type (assuming that java is on your path)

java -cp distcomp.jar com.mathworks.toolbox.distcomp.test.MulticastTester
0 : hostiname : O
1 : host2name : 0

Memory Errors on UNIX® Operating Systems

If the number of threads created by the server services on a UNIX®-based
machine exceeds the limitation set by the maxproc value, the services will fail
and generate an out-of-memory error. You can check your maxproc value on a
UNIX-based system with the 1imit command. (Different versions of UNIX
software might have different names for this property instead of maxproc,
such as descriptors on Solaris™ operating systems.)

Running Server Processes from a Windows®-Based
Network Installation

Many networks are configured not to allow LocalSystem to have access to
UNC or mapped network shares. In this case, run the mdce process under
a different user with rights to log on as a service. See “Setting the User”
on page 2-11.
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Required Ports

Using a Job Manager

BASE_PORT. The ports required by the job manager and all workers are
specified and described in the mdce_def file. See the following file in the
MATLAB installation used for each cluster process:

® matlabroot/toolbox/distcomp/bin/mdce_def.sh (on UNIX operating
systems)

® matlabroot\toolbox\distcomp\bin\mdce_def.bat (on Windows
operating systems)

Parallel Jobs. The range of ports on UNIX-based worker machines required
by MPICH for the running of parallel jobs is from BASEPORT + 1000 up to
BASE_PORT + 2000.

Using a Third-Party Scheduler

Before the worker processes start, you can control the range of ports used
by the workers for parallel jobs by defining the environment variable
MPICH_PORT_RANGE with the value minport:maxport.

Client Ports

You can specify the ports used by the client with the pctconfig function.
With this function you can ports separately for communication with the job
manager and communication with pmode or a matlabpool, if the default ports
cannot be used.

Ephemeral TCP Ports with Job Manager

If you use the job manager on a Windows-based cluster, you must make sure
that a large number of ephemeral TCP ports are available on the job manager
machine. By default, the maximum valid ephemeral TCP port number on a
Windows operating system is 5000, but transfers of large data sets might
fail if this setting is not increased. In particular, if your cluster has 32 or
more workers, you should increase the maximum valid ephemeral TCP port
number, with the following procedure:
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1 Start the Registry Editor.
2 Locate the following subkey in the registry, and then click Parameters:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters

3 On the Edit menu, click New, and then add the following registry entry:

Value Name: MaxUserPort

Value Type: DWORD

Value data: 65534

Valid Range: 5000-65534 (decimal)

Default: 0x1388 (5000 decimal)

Description: This parameter controls the maximum port number that is
used when a program requests any available user port from the system.
Typically , ephemeral (short-lived) ports are allocated between the
values of 1024 and 5000 inclusive.

4 Quit Registry Editor.

5 Reboot your machine.
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Admin Center

Starting Admin Center (p. 3-2) Describes how to open the tool

Running Tests in Admin Center Describes how to run tests in the tool
(p. 3-3)



3 Admin Center

Starting Admin Center

Admin Center is a graphical user interface that allows you to verify the
installation and configuration of MATLAB® Distributed Computing Server™
software if you are using a job manager as your scheduler. The tool tests

communications between your job manager node, worker nodes, and client
node.

You start Admin Center by selecting Parallel > Admin Center in the
MATLAB® desktop.

Parallel Desktop ‘Wwindow Help »

Select Configuration F Fument
; Manage Configurations...

Alternatively, you can start Admin Center outside a MATLAB session by
executing the following:

e matlabroot/toolbox/distcomp/bin/admincenter (on UNIX® operating
systems)

* matlabroot\toolbox\distcomp\bin\admincenter.bat (on Windows®
operating systems)



Running Tests in Admin Center

Running Tests in Admin Center

The first page of Admin Center is the Introduction, which provides a brief
overview of the tool’s tests and requirements.

) Admin Center =[O
File GoTo Help
Irtroduction Introduction |
Load Cluster Welcome to Admin Center
View/Edit Cluster
Run Tests A System Administration Toolkit for Parallel and Distributed Computing Using MATLAB &
iew Test Results MATLAR Worker
MATLAE Bistributed
Compuring Sarver
MATLAB Client Scheduler MATLAB Worker
poralel or MATLAE Bistributed
GT-nww Job Manager Computing Sarver
MATLAB Worker
MATLAB Distributed
Compuiing Swrver
Checks for,

@ Mecessary network connectivity

@ Firewall issues

& Presence of MATLAB Distributed Computing Server ™
# Potential MPI communication issues

Requirements

& For clusters using the job manager
@ For cluster compute nodes with MATLAE Distributed Computing Server already installed and running

For futther information on MATLAE, Parallel Computing Toolbox ™, or MATLAR Distibuted Computing Server, select "Estemnal Links" in the "Help"
pull-dovn menu,

Frey/ous Hext

You can proceed through the stages of the testing by clicking Next in the
lower right corner of each page. Alternatively, you can navigate using the
nodes in the left pane to move freely to any page.
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). Admin Center 9 [=]
File GoTo Help

‘Load Cluster ‘

Intraduction
Load Cluster Choose your source for loading cluster information
WiewlEdit Cluster
" Do Mot Change Cluster Information
Run Tests
Yiew Test Results Use the most recently entered cluster information. Use this option if pour cluster definition has

nat changed, ar you anly need to manually make minar modifications to your cluster definition.

" From Job Manager

‘whe will try to discower your cluster information from the job manager vou specif.

Job Manager Hostriame
Base Port

 Import From Session File

Load cluster information that was previously exported to file.

Efoise

& Manual

Clear any previous session data. Enter the hostnames of all cluster machines manually.

Frevious Mext

Admin Center allows you to identify your cluster from one of several sources:

¢ Do Not Change Cluster Information — This option causes Admin
Center to use the cluster you have already defined. (This option does not
appear the first time you run Admin Center, because no cluster has been
defined yet.)

¢ From Job Manager — This option defines the cluster by examining which
workers are registered with the identified job manager.

¢ Import From Session File — This option uses a cluster that had
previously been defined and exported to a file.

e Manual — This option allows you to type in the names of your cluster
nodes on the next page.
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After you choose the means of defining your cluster, the View/Edit Cluster
page allows you to make further modifications to the cluster list. You must
also identify which node in the cluster is running the scheduler.

Enter a job manager base port number if the default has been overridden by a
setting in the mdce_def file.

Admin Center

Intraduction
Load Cluster

Run Tests
Wiew Test Results
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The Run Tests page tells you what tests will run on your cluster.

) Admin Center
File GoTo Help

9 [=] B

Intraduction
Load Cluster
Wiew'Edit Cluster

Wiew Test Results

‘Run Tests

The following tests will be wn to determine whether your cluster is ready for parallel computing with MATLAB.

Cl
" - Client-Only Tests

- Client to Nods

- Node Hostname Resolution
- Connection to MATLAE Distibuted Computing Server
- Hostname Consistency on MATLAR Distibuted Computing S erver

- Nodes to Mod

- MPI Hostname Consistency
- Node Hosthame Resalution (A1l ta All)
- Mode Port Availability

- Mode Port Connection

Nodes to Client
" - Client Hostname Resolution and Port Connection

Frevious Mext

The tests are divided into four categories:

¢ Client — Verifies that the node running Admin Center is properly

configured so that further cluster testing can proceed.

¢ Client to Nodes — Verifies that the node running Admin Center can
identify and communicate with the other nodes in the cluster.

* Nodes to Nodes — Verifies that the other nodes in the cluster can identify
each other, and that each node allows its mdce service to communicate with

the mdce service on the other cluster nodes.

* Nodes to Client — Verifies that other cluster nodes can identify and
communicate with the node running Admin Center.

Click Next to begin execution of the tests.
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During test execution, Admin Center displays this progress dialog box.

Running Tests...




3 Admin Center

When the tests are all complete, the Running Tests dialog automatically
closes, and Admin Center displays the View Test Results page.

Admin Center

Introduction
Load Cluster
Wiew'Edit Cluster
Run Tests
st
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The possible test result symbols are described in the following table:

Test Result Description

v Test passed.

@® Test passed, extra information is available.
LN Test passed, but generated a warning.

X Test failed.

Test was skipped, possibly because prerequisite tests did
e not pass.

Click any of the symbols in the test results to drill down for more detail. Use
the Log tab to see the raw data from the tests.

By default, Admin Center saves the cluster definition and test results, so

the next time the same user runs Admin Center on the same machine, that
information is available. You can export session data so that it can be accessed
by a different user or on a different machine by selecting File > Export.
Browse to the location where you want to store the session data and provide a
name for the file. Admin Center applies the extension .mps to the file name.

You can import that saved session data into a subsequent sessions of Admin
Center by selecting File > Import, or by selecting Import From Session
File on the Load Cluster page. The imported data includes cluster definition
and test results.
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Control Script Reference

mdce Process Control (p. 4-2) Control mdce service
Job Manager Control (p. 4-2) Control job manager
Worker Control (p. 4-2) Control MATLAB® workers



4 conirol Script Reference

4-2

mdce Process Control

mdce

nodestatus

Job Manager Control

startjobmanager

stopjobmanager

Worker Control

startworker

stopworker

Install, start, stop, or uninstall mdce
service

Status of mdce processes running on
node

Start job manager process

Stop job manager process

Start MATLAB® worker session
Stop MATLAB worker session



Control Scripts —
Alphabetical List




mdce

Purpose

Syntax

Description

Install, start, stop, or uninstall mdce service

mdce install

mdce uninstall

mdce start

mdce stop

mdce console

mdce restart

mdce ... -mdcedef <mdce_defaults_file>
mdce status

The mdce service ensures that all other processes are running and that
it is possible to communicate with them. Once the mdce service is
running, you can use the nodestatus command to obtain information
about the mdce service and all the processes it maintains.

mdce install installs the mdce service in the Microsoft® Windows®
Service Control Manager. This causes the service to automatically start
when the Windows operating system boots up. The service must be
installed before it is started.

mdce uninstall uninstalls the mdce service from the Windows Service
Control Manager. Note that if you wish to install mdce service as a
different user, you must first uninstall the service and then reinstall
as the new user.

mdce start starts the mdce service. This creates the required logging
and checkpointing directories, and then starts the service as specified
in the mdce defaults file.

mdce stop stops running the mdce service. This automatically stops all
job managers and workers on the computer, but leaves their checkpoint
information intact so that they will start again when the mdce service
is started again.

mdce console starts the mdce service as a process in the current
terminal or command window rather than as a service running in the
background.



mdce

See Also

mdce restart performs the equivalent of mdce stop followed by mdce
start. This command is available only on UNIX® and Macintosh®
operating systems.

mdce ... -mdcedef <mdce defaults file> uses the specified
alternative mdce defaults file instead of the one found in
matlabroot/toolbox/distcomp/bin.

mdce status reports the status of the mdce service, indicating whether
it is running and with what PID. Use nodestatus to obtain more
detailed information about the mdce service. The mdce status
command is available only on UNIX and Macintosh operating systems.

nodestatus, startjobmanager, startworker, stopjobmanager,
stopworker



nodestatus

Purpose

Syntax

Description

Status of mdce processes running on node

nodestatus
nodestatus -flags

nodestatus displays the status of the mdce service and the processes
which it maintains. The mdce service must already be running on the

specified computer.

nodestatus -flags accepts the following input flags. Multiple flags
can be used together on the same command.

Operation

-remotehost <hostname>

Displays the status of the mdce
service and the processes it
maintains on the specified host.
The default value is the local host.

-infolevel <level>

Specifies how much status
information to report, using

a level of 1-3. 1 means only
the basic information, 3 means
all information available. The
default value is 1.

-baseport <port_number>

Specifies the base port that the
mdce service on the remote host
is using. You need to specify this
only if the value of BASE_PORT in
the local mdce_def file does not
match the base port being used
by the mdce service on the remote
host.

Verbose mode displays the
progress of the command
execution.




nodestatus

Examples Display basic information about the mdce processes on the local host.

nodestatus

Display detailed information about the status of the mdce processes
on host node27.

nodestatus -remotehost node27 -infolevel 2

See Also mdce, startjobmanager, startworker, stopjobmanager, stopworker



startjobmanager

Purpose Start job manager process

Syntax startjobmanager
startjobmanager -flags

Description startjobmanager starts a job manager process and the associated
job manager lookup process under the mdce service, which maintains
them after that. The job manager handles the storage of jobs and the
distribution of tasks contained in jobs to MATLAB® workers that are
registered with it. The mdce service must already be running on the

specified computer.

startjobmanager -flags accepts the following input flags. Multiple
flags can be used together on the same command.

Operation

-name <job_manager_name>

Specifies the name of the job
manager. This identifies the job
manager to MATLAB worker
sessions and MATLAB clients.
The default is the value of the
DEFAULT_JOB_MANAGER_NAME
parameter in the mdce_def file.

-remotehost <hostname>

Specifies the name of the host
where you want to start the job
manager and the job manager
lookup process. If omitted, they
are started on the local host.

-clean

Deletes all checkpoint
information stored on disk

from previous instances of this
job manager before starting. This
will clean the job manager so that
it will initialize with no jobs or
tasks.




startjobmanager

Flag Operation

-multicast Overrides the use of unicast to
contact the job manager lookup
process. It is recommended

that you not use -multicast
unless you are certain that
multicast works on your network.
This overrides the setting

of JOB_MANAGER_HOST in the
mdce_def file on the remote
host, which would have the job
manager use unicast. If this flag
is omitted and JOB_MANAGER_HOST
is empty, the job manager uses
unicast to contact the job manager
lookup process running on the
same host.

-baseport <port_number> Specifies the base port that the
mdce service on the remote host
is using. You need to specify this
only if the value of BASE_PORT in
the local mdce_def file does not
match the base port being used
by the mdce service on the remote

host.

Y Verbose mode displays the
progress of the command
execution.

Examples Start the job manager MyJobManager on the local host.

startjobmanager -name MyJobManager



startjobmanager

Start the job manager MyJobManager on the host JMHost.

startjobmanager -name MyJobManager -remotehost JMHost

See Also mdce, nodestatus, startworker, stopjobmanager, stopworker



startworker

Purpose

Syntax

Description

Start MATLAB® worker session

startworker
startworker -flags

startworker starts a MATLAB worker process under the mdce service,
which maintains it after that. The worker registers with the specified
job manager, from which it will get tasks for evaluation. The mdce
service must already be running on the specified computer.

startworker -flags accepts the following input flags. Multiple flags
can be used together on the same command, except where noted.

Operation

-name <worker_name>

Specifies the name of the
MATLAB worker. The

default is the value of the
DEFAULT_WORKER_NAME parameter
in the mdce_def file.

-remotehost <hostname>

Specifies the name of the
computer where you want to start
the MATLAB worker. If omitted,
the worker is started on the local
computer.

-jobmanager
<job_manager_name>

Specifies the name of the job
manager this MATLAB worker
will receive tasks from. The
default is the value of the
DEFAULT_JOB_MANAGER_NAME
parameter in the mdce_def file.




startworker

Flag

Operation

- jobmanagerhost <jmhostname>

Specifies the host on which the
job manager is running by using
-jobmanagerhost. The worker
will then use unicast to contact
the job manager lookup process
on that host in order to register
with the job manager.

This overrides the setting

of JOB_MANAGER_HOST in the
mdce_def file on the worker
computer, which would also have
the worker use unicast.

Cannot be used together with
-multicast.

-multicast

If you are certain that multicast
works on your network, you can
force the worker to use multicast
to locate the job manager lookup
process by specifying -multicast.
Note: If you are using this flag to
change the settings of and restart
a stopped worker, then you should
also use the -clean flag.

Cannot be used together with
- jobmanagerhost.

-clean

Deletes all checkpoint
information associated with
this worker name before starting.

5-10



startworker

Examples

Flag Operation

-baseport <port_number> Specifies the base port that the
mdce service on the remote host
is using. You only need to specify
this if the value of BASE_PORT in
the local mdce_def file does not
match the base port being used
by the mdce service on the remote
host.

-V Verbose mode displays the
progress of the command
execution.

Start a worker on the local host, using the default worker name,
registering with the job manager MyJobManager on the host JVHost.

startworker -jobmanagername MyJobManager -jobmanagerhost JMHost

Start a worker on the host WorkerHost, using the default worker name,
and registering with the job manager MyJobManager on the host JMHost.
(The following command should be entered on a single line.)

startworker -jobmanagername MyJobManager -jobmanagerhost JMHost
-remotehost WorkerHost

Start two workers, named worker1 and worker2, on the host
WorkerHost, registering with the job manager MyJobManager that is
running on the host JMHost. Note that to start two workers on the
same computer, you must give them different names. (Each of the two
commands below should be entered on a single line.)

startworker -name workeri -remotehost WorkerHost

- jobmanagername MyJobManager -jobmanagerhost JMHost
startworker -name worker2 -remotehost WorkerHost

- jobmanagername MyJobManager -jobmanagerhost JMHost
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See Also mdce, nodestatus, startjobmanager, stopjobmanager, stopworker
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stopjobmanager

Purpose

Syntax

Description

Stop job manager process

stopjobmanager
stopjobmanager -flags

stopjobmanager stops a job manager that is running under the mdce

service.

stopjobmanager -flags accepts the following input flags. Multiple
flags can be used together on the same command.

Operation

-name <job_manager_name>

Specifies the name of the
job manager to stop. The
default is the value of
DEFAULT_JOB_MANAGER_NAME
parameter the mdce_def file.

-remotehost <hostname>

Specifies the name of the host
where you want to stop the job
manager and the associated job
manager lookup process. The
default value is the local host.

-baseport <port_number>

Specifies the base port that the
mdce service on the remote host
is using. You need to specify this
only if the value of BASE_PORT in
the local mdce_def file does not
match the base port being used
by the mdce service on the remote
host.

Verbose mode displays the
progress of the command
execution.
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Examples Stop the job manager MyJobManager on the local host.

stopjobmanager -name MyJobManager

Stop the job manager MyJobManager on the host JVHost.

stopjobmanager -name MyJobManager -remotehost JMHost

See Also mdce, nodestatus, startjobmanager, startworker, stopworker



stopworker

Purpose

Syntax

Description

Stop MATLAB® worker session

stopworker
stopworker -flags

stopworker stops a MATLAB worker process that is running under

the mdce service.

stopworker -flags accepts the following input flags. Multiple flags
can be used together on the same command.

Operation

-name <worker_name>

Specifies the name of the
MATLAB worker to stop.

The default is the value of the
DEFAULT_WORKER_NAME parameter
in the mdce_def file.

-remotehost <hostname>

Specifies the name of the host
where you want to stop the
MATLAB worker. The default
value is the local host.

-baseport <port_number>

Specifies the base port that the
mdce service on the remote host
is using. You need to specify this
only if the value of BASE_PORT in
the local mdce_def file does not
match the base port being used
by the mdce service on the remote
host.

Verbose mode displays the
progress of the command
execution.
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Examples Stop the worker with the default name on the local host.

stopworker

Stop the worker with the default name, running on the computer
WorkerHost.

stopworker -remotehost WorkerHost

Stop the workers named worker1 and worker2, running on the
computer WorkerHost

stopworker -name workeri -remotehost WorkerHost
stopworker -name worker2 -remotehost WorkerHost

See Also mdce, nodestatus, startjobmanager, startworker, stopjobmanager
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CHECKPOINTBASE
The name of the parameter in the mdce_def file that defines the location
of the job manager and worker checkpoint directories.

checkpoint directory
Location where job manager checkpoint information and worker
checkpoint information is stored.

client
The MATLAB® session that defines and submits the job. This is the
MATLAB® session in which the programmer usually develops and
prototypes applications. Also known as the MATLAB® client.

client computer
The computer running the MATLAB® client.

cluster
A collection of computers that are connected via a network and intended
for a common purpose.

coarse-grained application
An application for which run time is significantly greater than
the communication time needed to start and stop the program.
Coarse-grained distributed applications are also called embarrassingly
parallel applications.

computer
A system with one or more processors.

distributed application
The same application that runs independently on several nodes,
possibly with different input parameters. There is no communication,
shared data, or synchronization points between the nodes. Distributed
applications can be either coarse-grained or fine-grained.

distributed array
An array partitioned into segments, with each segment residing in the
workspace of a different lab.
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Glossary

Glossary-2

distributed computing
Computing with distributed applications, running the application on
several nodes simultaneously.

distributed computing demos
Demonstration programs that use Parallel Computing Toolbox™
software, as opposed to sequential demos.

DNS
Domain Name System. A system that translates Internet domain
names into IP addresses.

dynamic licensing
The ability of a MATLAB® worker or lab to employ all the functionality
you are licensed for in the MATLAB® client, while checking out only a
server product license. When a job is created in the MATLAB® client
with Parallel Computing Toolbox™ software, the products for which
the client is licensed will be available for all workers or labs that
evaluate tasks for that job. This allows you to run any code on the
cluster for which you are licensed on your MATLAB® client, without
requiring extra licenses for the worker beyond that for the MATLAB®
Distributed Computing Server™ product. For a list of products that are
not eligible for use with Parallel Computing Toolbox™ software, see
http://www.mathworks.com/products/ineligible programs/.

fine-grained application
An application for which run time is significantly less than the
communication time needed to start and stop the program. Compare to
coarse-grained applications.

head node
Usually, the node of the cluster designated for running the job manager
and license manager. It is often useful to run all the nonworker-related
processes on a single machine.

heterogeneous cluster
A cluster that is not homogeneous.

homogeneous cluster
A cluster of identical machines, in terms of both hardware and software.
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job
The complete large-scale operation to perform in MATLAB®, composed
of a set of tasks.

job manager
The MathWorks process that queues jobs and assigns tasks to workers.
A third-party process that performs this function is called a scheduler.
The general term “scheduler” can also refer to a job manager.

job manager checkpoint information
Snapshot of information necessary for the job manager to recover from
a system crash or reboot.

job manager database
The database that the job manager uses to store the information about
its jobs and tasks.

job manager lookup process
The process that allows clients, workers, and job managers to find each
other. It starts automatically when the job manager starts.

lab
When workers start, they work independently by default. They can
then connect to each other and work together as peers, and are then
referred to as labs.

LOGDIR
The name of the parameter in the mdce_def file that defines the
directory where logs are stored.

MATLAB® client
See client.

MathWorks® job manager
See job manager.

MATLAB® worker
See worker.
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mdce
The service that has to run on all machines before they can run a job
manager or worker. This is the server foundation process, making sure
that the job manager and worker processes that it controls are always
running.

Note that the program and service name is all lowercase letters.

mdce_def file
The file that defines all the defaults for the mdce processes by allowing
you to set preferences or definitions in the form of parameter values.

MPI
Message Passing Interface, the means by which labs communicate with
each other while running tasks in the same job.

node
A computer that is part of a cluster.

parallel application
The same application that runs on several labs simultaneously, with

communication, shared data, or synchronization points between the
labs.

private array
An array which resides in the workspaces of one or more, but perhaps
not all labs. There might or might not be a relationship between the
values of these arrays among the labs.

random port
A random unprivileged TCP port, i.e., a random TCP port above 1024.

register a worker
The action that happens when both worker and job manager are started
and the worker contacts job manager.

replicated array
An array which resides in the workspaces of all labs, and whose size and
content are identical on all labs.
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scheduler
The process, either third-party or the MathWorks® job manager, that
queues jobs and assigns tasks to workers.

task
One segment of a job to be evaluated by a worker.

variant array
An array which resides in the workspaces of all labs, but whose content
differs on these labs.

worker
The MATLAB® process that performs the task computations. Also

known as the MATLAB® worker or worker process.

worker checkpoint information
Files required by the worker during the execution of tasks.
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